3D Geostatistical Interpolation with gOcad
short course materials

Chair of Geoscience Mathematics and Informatics
Department of Geophysics and Geoinformatics
TU Bergakademie Freiberg
1.1. The problem

Geometry and properties of geological objects are only accurately known at certain sampling locations and have to be interpolated, estimated or simulated for the remaining object. Following Jean-Laurent Mallet, "Geomodelling consists of the set of mathematical and computer science methods allowing to model the topology, the geometry and the properties of geological objects in an unified way while taking into account any type of data related to these objects". This implies that a modelling geologist has to

1. subdivide the volume of interest into a set of geoobjects according to the project motivation, like a set of fault blocks, horizons, reservoirs, ore bodies . . . .
2. compile all data related to these geoobjects in order to constrain the topology, geometry and properties in an optimum way. Such data can be of heterogeneous type, certainty and spatial distribution.
3. use appropriate methods to create self-consistent 3D geomodels composed of geoobjects. These need to honor available data. Examples are interpolation, estimation and simulation methods.

1.2. Discrete Model

In order to store spatial data and geoobjects in a computer, a discrete data model is required (fig. a). Discrete geoobject representation is based on regular or irregular tessellations to model the spatial extent of geoobjects using surface partitions or volume partitions.

Fig. 1. a. Discretization of the Model Space into Regions Corresponding to Geoobjects (Model3d, left), and Discretization of a Geoobject into 3d Cells (SGrid, right).

Discrete topological model. The Boundary Representation (BRep) approach models the spatial extent of geoobjects by a discretization of their boundary. Using this technique, the geological space can be partitioned into regions. The radial edge Weiler representation implemented in gOcad Model3d objects maintains a hierarchy of topological elements. Each level of the hierarchy corresponds to various stages of the discretization process as one moves from a geomodel down to a mesh with its associated numerical properties. The abstraction hierarchy is comprised by the following models:

1. discrete model (geometry and property model).
2. discrete topological model.
It is composed of
1. volume region decomposition
2. face decomposition
3. border decomposition
4. triangulated mesh

**Discrete model.** A discrete model stores the topological information and the geometry, constraints and properties. In gOcad, this information is stored at the nodes of Model3d, Surfaces, Solids, Curves, or PointsSet objects. By definition, a discrete model $M^0(\Omega, N, \varphi, C)$ consists of a graph $G(\Omega, N_i)$ defining the topological neighborhood $N_i$ of the set of nodes $\Omega$, vectorial functions $\varphi^\alpha$ defining the geometry and properties of each node $\alpha$, a set of linear constraints $C_i$, which can be chosen and weighted in order to let $\varphi^\alpha$ honor data and geological concepts.

### 1.3. Data model

The most primitive model object available is the PointsSet, which is composed of a set of points possessing properties such as geometry (XYZ coordinates) and arbitrary vectorial properties. Curves are nodes which are connected by linear segments (fig. b). Each node has two or one (in the case of an extremity) neighbour nodes. Curve objects can be composed of a set of isolated curve parts.

![Fig. 1. b. Different algorithms to connect points to curves or surfaces (left); Parameters describing a voxet (right)](image-url)

Triangulated surfaces are most important for modelling geological boundary surfaces. Planar triangles are interpolated between a set of connected nodes. A surface object is composed of a set of isolated parts (faces, fig. b). Parts possess topological features like border (boundary) and borderstones. A sealed Model3d (BRep model) or an SGird that is composed of voxels (fig. b) can be built from a set of intersecting surface parts. The geometrical and property information of surfaces is stored at the points.

Solids are composed of connected tetrahedra. A volume region which represents a geoobject can be discretized using solids, which allows to model properties in 3d volumes. Again, the properties are stored at the nodes and interpolated between them. SGirds and Voxets are regular grids. Numerical properties can be carried by the cell nodes or the cell center. SGirds can be deformed and cut in order to fill the volume region of a geoobject. Such curvilinear SGirds are commonly used for property modeling in geoobjects, like hydrocarbon reservoirs. Parallelepipedic Voxets are similar to SGirds and often used for property modeling in gross volumes, like seismic cubes.
2. 1. **The user interface layout**

`gOcad` contains many toolbars that can be activated with `view → toolbars → tick`

The User interface (fig. a) is subdivided into the following areas:

1. **Main Menu Bar** - data load and save, general settings, general data management, data analysis applications, help access.
2. **Command Menu Bar** - used for object creation; topology, geometry and property editing, interpolation and computations. Upon start-up, the bar appears in General Mode, which can be changed to particular object modes (Surface Mode etc.) with respective functionality.
3. **Digitization Selection Bar and Digitization Editing Bar**
4. **Camera Settings Bar** - Here you can setup the camera position, AutoSetup will direct the camera towards all selected objects (fig. b). The dialog at the very right (default value: "1") allows to scale the Z axis for vertical exaggeration.
5. **Panel Selection Panel** - for Panel 6 choose between Workflow Panels, Object Panel, Attribute Panel or Camera Settings Panel.

6. **Object Panel** - lists the tree of all loaded objects and resources. By opening the tree, object properties and regions can be accessed. Using the right mouse button, you can access the attributes, apply scripts, create new objects and properties.

7. **3D-Camera** - shows the objects selected in the object panel in a cartesian coordinate system; left mouse button for spin, right mouse button for zoom. If the Camera Control Panel is activated using the Panel Selection Panel (5), camera settings can be changed like the increment of spin/pan/zoom actions carried out using the arrow keys (pan), numerical keys 2,4,6,8 (orbit) or numerical keys 2,4,6,8 and „+“ (zoom) of your keyboard. Selected objects can also be filtered according to many criteria.

8. **Camera Tools** - pick objects in the camera and get their attributes or properties; slicer.

9. **Attribute Quick Edit Bar** - depending on the currently highlighted objects in the Object Panel (6), the bar dynamically changes (fig. c) and allows to set the graphical object attributes. General hint: Many command actions correspond to standards: drag & drop, multiple selection of objects in the camera or dialogs: control or shift key, undo: control-z, save: control-s, repeat a command: space key.

**General Terms and Features**

**Attribute**: Attributes include all graphical properties of objects, like color.

**Coordinate System**: gOcad uses a cartesian and metric coordinate system like UTM. This means, all coordinates describing the geometry of an object are interpreted as meters (or feet). The units and the direction of the Z axis (vertical up or down) can be specified in the start-up project specification dialog (fig. d). Objects can be represented in time or depth. Attention!! The definition cannot be changed later!

**Command History**: The log of all gOcad commands executed in your session appears, when you click on the small triangle symbol left above the Attribute Quick Edit Bar (fig. e). The history is also stored in the file “history.gsc” in the current project directory.
**Objects:** represent geological objects and input data, like PointsSets, Curves, Surfaces, SGrids, and Wells. Objects can possess numerical and geological properties and subregions. Each object has a unique name (without whitespaces). The property at a point can be picked using the "XYZ?" icon in the Camera Toolbar (8). The result appears in the status bar.

**Operating system and Plugin development:** gOcad is programmed in ANSI C++ and allows to develop custom plugins. Qt is used as a widget library for user interfaces (www.trolltech.com). Thus, gOcad is available for different OS: MS Windows, Linux (PC), Irix, Solaris.

**OK-Apply-Cancel Buttons:** Note that OK executes a command and closes a dialog, while Apply keeps it. Sometimes you have to be careful and not press Apply + OK instead Apply + Cancel, as the command would be executed twice. Particularly, cut operations may cause troubles.
**Node, Point, Atom:** Point object that are used in a different context. Points are nodes, if we deal with topological objects and as Points if we deal with geometry. Atom store topology, geometry and constraints.

**Control point:** Data point controlling the geometry of the interpolated surfaces, can be weighted by priority, is stored with the gOcad object.

**Control node:** must be considered by the interpolation. It is always part of the surface and stored with the gOcad object.

**Border:** All triangle edges that are not shared by two triangles

**Border extremities:** are border stones subdividing a border.

**Part:** Some object types can be composed of isolated topological parts, for example, a surface object can be composed of several disconnected triangulated surface parts.

**Property:** Numerical properties, including the geometry, are generally stored as 32bit-float numbers at the nodes or cells of objects. Properties can be scalar or vectorial. For example, orientation data can be stored as vectors.

**Region:** A region is a named subset of nodes of a discrete model object. This can be used for selective object editing or data filtering.

**Storage:** gOcad objects can be stored either as ASCII files: File → Save Objects and File → Save Objects as ... or as binary gOcad Projects File → Save as Project ...

**Wizards:** Based on the command history of a gOcad session, it is possible to create text files containing gOcad commands in a workflow-like order. gOcad creates neat dialogs in a workflow-like style at runtime. Wizards can be accessed via Applications → Wizards.

**Workflows:** Plugins which guide the user through common tasks, for example Structural Modelling or Property Modelling.

### 2.3. Create a project

In gOcad, all objects and settings are stored in a Project directory. Launch gOcad in menu Start → All Programs → Paradigm → gOcad 2009.x or using the Desktop shortcut.

We will create a New Project in your working directory, name it simply project1. The next dialog allows to choose required modules. We will select the Structural Framework Builder. Finally, we need to specify the coordinate system and units and set the depth axis positive values: Upward which determines the direction of the Z axis.

After the project has been created, we can set some preferences:

*Edit → Preferences User level: Advanced, Default working folder ...: your working directory.*

On the page “Appearance”, you may set “Show text labels” in order to familiarize with the icons. Copy the tutorial data to your working directory.

You can check the project settings with *File → Project Properties.*
3.1 PointsSets

3.1.1 Characteristics of PointsSets

A PointsSet is the most primitive gOcad object. Numerical properties and regions are defined for the whole PointsSet object and stored with each point. For example, each point stores its XYZ coordinates and an arbitrary number of additional scalar or vectorial properties. Each point may contain flags indicating whether it belongs to subset regions of the PointsSet. Commonly, PointsSets are used as input data, like sampling points with orientation, geochemical or petrophysical measurements, or simply location data for terrain models. PointsSet gOcad objects are characterized by a *.vs file extension.

We will explore the characteristics and the manipulation of PointsSets using two data sets. The data set WellPoints.vs consists of 861 data points consisting of spatial and property values at each sampling point. By observing the data set in the 3D camera, you get a first impression of its spatial distribution: About 12 data points are located at an identical XY position that is coincident with one vertical well. The whole data set reproduces the geometry of an anticline with a curved hinge line. The data set describes a structural oil trap. Each data point comprises the properties core porosity, log porosity and permeability. Create a gOcad project and import the PointsSets as column-based file.

If you tick the object name wellpoints in the object panel, the Attribute Quick Edit Bar below the object panel changes dynamically and you can set the symbol type, color and size.

3.1.2 Display properties of a PointsSet

If you want to visualize properties, just choose one and highlight its name. Again, the Attribute Quick Edit Bar changes and you can assign appropriate graphical property attributes, like color maps. Another way to manipulate graphical attributes is to click on the object name with the right mouse bottom and to enter the attribute window.

Color coding of properties

You can change the layout of the points and the color bar for the properties in the Quick Edit Bar appearing when you click on the selected property. You can also read the minimum and maximum values of the property. The colored arrow resets the color map to the minimum and maximum values of the PointsSet.

Let’s have a look at the areal distribution of the data set:

Simple statistics functions

If you want get a better understanding about the distribution of your data, you may employ simple statistic functions with
Let’s check all three properties with the histogram tool and let’s answer the following questions:

How are the properties distributed (uni- or multimodal, symmetric or asymmetric)? Which characteristic numbers do they have? Do you find outliers?

Histogram ➔ object: WellPoints ➔ region: everywhere ➔ property: coreporosity ➔ read the characteristic numbers in the first box on the left side ➔ always play with the number of bins change to 100 decrease to 20 to see whether new peaks appear ➔ interpret number of modes, skewness, geometry of the distribution

The porosity has a bimodal distribution with two peaks. This phenomenon is either an indication that the data set includes multiple geological units like clay lenses in a sandstone or that rock formation was affected by secondary processes like cementation of pore space.

Instead, the permeability that is expected to be a function of the porosity, is skewed to the right and looks like a log-normal distribution. Therefore, let’s change the scale to log10 and have a look at the data. Now, we observe again the bimodal distribution found in the porosity histograms. Another thing is important in the permeability set: We notice outliers with extremely high porosities. This may indicate the existence of a thief zone in the reservoir. A thief zone is a very permeable formation encountered during drilling into which circulating fluids can be lost. Thief zones, which include crevices, cavens and porous formations, must be sealed off with a liner or plugged with special cements or fibrous clogging agents before drilling can resume. Therefore, it is important to discover and to locate the thief zone. Where is the thief zone located?

You can check it quickly using the color map clip value and transparency settings (fig. a).

The bivariate data analysis deals with the relation between two properties and can be performed with the cross plot tool that can create and scale cross plots. Additionally, Pearson’s correlation coefficient and the linear regression coefficient are displayed. For better data analysis, the data have to be exported to statistics software like S-Plus or R.

How are the properties related to one another? Plot the cross plots and scale them, change the scale from linear to logarithmic, if necessary.

You see that the core porosity and the log porosity are highly correlated, but are not equal. The core porosity is systematically higher then the log porosity, which may be caused by expansion of the core after its exhumation. Since the log porosity was measured in situ, we assume it to be more realistic and will work with it. If you print a cross plot between log porosity and permeability, you find that there may be a functional relation between both properties, but that this relation is not linear. This is evidenced by a difference in the correlation and rank correlation coefficient. If you logarithmize the permeability, the correlation coefficient is increasing considerably, however, the regression line is still somewhat asymmetric, which is caused by the outliers pulling the regression line upward. Create a region „without_outliers“ and create a new regression model. Now, you see that it is more symmetric and the correlation coefficient as well as the coefficient of determination are better.

gOcad offers a tool to view 3D cross plots, but a real multivariate data analysis has to be performed in an external statistics software.

3.1.3. Define Regions

If you are interested in values of certain range or want to query point properties, you may select them and assign them to a region. Create and initialize a region containing the permeability values that are bigger than 600 (fig. b)!

Region ➔ Create ➔ object: WellPoints ➔ region: thiefzone

Region ➔ Initialize ➔ from property range ➔ object: WellPoints ➔ region: thiefzone ➔ property: perm ➔ use min: 600 ➔ ok
3.1.4. Apply scripts on GoCad objects

Now we load a different type of data, a simple ASCII file DEM.txt containing points representing terrain elevation data (X and Y in m, Z in dm).

File → Import Objects → Horizon Interpretations → PointsSets → XYZ → DEM.txt

You don't see the data in your 3D camera although the PointsSet is ticked in the object panel? The 3D camera is still focused at the wellPoints, and we need to set it up to show the new object which is located somewhere else. Deselect wellPoints in the object panel and click on the global view icon in the Camera Settings Bar (4)! In order to represent the object in proper geometry, we need to convert the Z values to meters.

Right click at dem_utm in the object panel → copy → dem

point set mode → compute → apply script → on Object

Select dem as object and enter the main script: “z=z/10;”. → Check → ok

Each script ends with “;”. You can check the syntax of the script by clicking “Check”, and watching the GoCad status bar, and then click either OK or Apply and Cancel. Why? OK executes the command and closes the dialog, Apply executes the command and keeps the dialog. Pressing Apply and then OK would result in twice executing the command, which is not wanted in our example.

Property scripts are very useful tools for various tasks and can be applied for all GoCad objects likewise. A rich set of mathematical functions is available. For example, scripts may be used to compute saturation values in SGrids:

\[ Sh = 1 - \sqrt{\frac{30}{\text{resistivity} \times \text{pow(porosity, 2)}}}; \]
3.2. Curve objects

3.2.1. Characteristics of curve objects

Curve objects are points connected by line segments. Files containing gOcad curve objects have the extension *.pl. In contrast to PointsSets, curves can be projected on surfaces.

File → Load Objects → "curve_topology.pl" → Choose view from top

![Fig. 3.c. Curve Topology: sphere: border extremity, octaeder: curve node](image)

The fig. a shows the curve object curve_topology, which you can load into gOcad: It is composed of three isolated parts. The left and the right part consist of 3 nodes, while the middle part consists of four nodes. The difference is topological: The left part has two extremities (grey spheres): two nodes have only one neighbour. In the middle part, two extremity nodes have the same geometry, but are not connected. If you are curious, you can explore how the topology is stored by having a look at the file in an editor.

3.2.2. Import of curve objects

Now, we want to load two curve objects containing contour lines describing the geometry of the upper and lower boundary of the geological body containing the drill holes

Main menu → file → load objects → "top_isoline", "bottom_isoline"

The curve objects contain several properties: X, Y, Z and elevation. You see, that the Z values of all line objects are constant and that you look at isolines in a map. The height of each isoline is saved in the property elevation, and if we want to build a 3D model, we have to assign the elevations to the Z values.

PointsSet → compute → apply script → on object → main script Z=elevation;

3.2.3. Editing of curve objects

You can edit the curve object with the tools offered in the Curve → Tools menu.

You can drag one node with the mouse with

Curves → tools → node → drag with mouse (you can repeat this function by pressing the space button)

Curve → tools → segment → split allows to add a new node

Curve → tools → node → disconnect allows to divide the curve

Curve → tools → node → bridge allows to connect to parts of one curve

Curve → tools → Node link → links extremities → reconstruct curve from links allows to close a curve.

3.3. Triangulated surfaces

3.3.1. Surface topology

Load the gOcad object surface_topology_parts.tst!
A surface object comprises several constituents: triangles, nodes, borders, border extremities and constraints (fig. c). You can control the display these elements in the Quick Attribute Toolbar, when you tick one surface object in the object panel and leave the object highlighted. A surface object can be composed of several isolated parts, each having one border. The cut creates two topologically isolated parts. The borders can be subdivided by border extremities. If parts are merged, the border between the parts disappears and the border extremities can be deleted.

Surface → Tools → Parts → Merge All
Surface → Tools → border extremity → delete → pick extremities in the 3D camera

Fig. 3.d. Topological elements and parts of surfaces. After a cut, nodes along the cut line are duplicated and belong to a border. The nodes of the borders have the same location but are not connected. Each border has at least one border extremity. If the surface parts are merged, the triangles on both sides of the borders are connected and the border disappears.

3.3.2. Surface Interpolation

For creating geomodels which honor available geological data, a unique interpolation method is available in gOcad named Discrete Smooth Interpolation. This method allows to interpolate the functions of the discrete model, like geometry or properties, while honoring a set of constraints \( C_i \). Several kinds of constraints can be distinguished. So-called hard equality constraints are control nodes, which are not allowed to move. Soft equality constraints are control points, these are nodes of another object which should be honored in a least squares sense. Other possible constraints are for example vectorial links between nodes, range constraints, gradient constraints. The DSI algorithm converges towards a solution where \( R \) is the local roughness at node \( \alpha \), \( \rho \) is a constraint defined for node \( \alpha \), \( \mu \) is a stiffness coefficient, and \( \omega \) and \( \omega^* \) are weight coefficients. This generic method allows the usage of heterogeneous data as constraints for the interpolation. It is always reproducible, on what primary data an interpolated object is based on. In gOcad, a comprehensive set of constraints is implemented. Simultaneously, DSI guarantees that the interpolation result is as smooth as possible.

\[
R^*(\varphi) = \sum_{\alpha \in \Omega} \mu(\alpha) \cdot R(\varphi|\alpha) + (\phi \cdot \overline{w}) \cdot \sum_{c \in C \approx} \omega_c \cdot \rho(\varphi|c) \tag{1}
\]
For interpolating a surface, four steps are necessary: create a surface, split the surface, set constraints, interpolate.

Surface ➔ New ➔ from PointSets ➔ PointSets Medium Plane ➔ name: top_surface ➔ AtomsSet: top_isoline ➔ Clip with XYZ ➔ ok

This tool creates a trend surface with a minimum distance to the points of the AtomsSet. In order to interpolate a surface that follows the shape of the PointsSet, we have to split the surface in several triangles. Then, we set the points of the AtomsSet as control points and interpolate. You can play with the fitting factor in the “Advanced” menu that can be set to 0 for creating smooth surfaces and to a maximum value of 2 in order to honor the data. The fitting factor corresponds to the coefficient $\mu$ in the global DSI equation. DSI is an iterative algorithm, you can run more iterations by clicking “Apply” several times.

Surface ➔ Tools ➔ Split ➔ All ➔ top_surface ➔ Apply+Apply+Apply

Surface ➔ Constraints ➔ Control Points ➔ Set Control Points—AtomsSet: top_isoline

Surface ➔ Interpolation ➔ Geometry ➔ On Entire Surface ➔ top_surface ➔ tick smooth ➔ ok

Surface ➔ Interpolation ➔ Geometry ➔ On Entire Surface ➔ top_surface ➔ advanced ➔ tick conjugate ➔ ok

The DSI algorithm tries to minimize the roughness of the surface, and one side effect is that it minimizes the area of the surface: If you press several times apply, the surface will shrink (fig. c). In order to avoid this, we have to set constraints on the boundaries of the surface.

Fig. 3.f. Interpolation with and without constraints on borders. If no constraints on border are set, the corners of the surface are rounded.

3.3.3. Create a bounding box and set boundary constraints

You can crate two types of bounding boxes: one that is surrounding the data set and one that is parallel to the XYZ axes.

Voxel ➔ New ➔ from objects box (is parallel to the axis)

Voxel ➔ New ➔ from objects cage (fits the geometry of the objects)

Now, create a new PointsSet Medium Plane with the name top_surface, clip it with the voxel, split it and set control points! Add border constraints to avoid the shrinking of the surface!

Surface ➔ Constraints ➔ Constraints on Borders ➔ All Borders ➔ ok

Interpolate a surface with high fitting factor!
3.4. SGrids

3.4.1. Introduction

SGrids are regular 3D grids which can be deformed and cut to fit a structural surface model. This sort of discretized volume is necessary, if we want to model the distribution of a property in a geological body. The grid axes are by default parallel to the XYZ axes of the model, but can be defined in a different way by the user.

In this exercise, we will model a part of a gold bearing quartz vein by creating a simple surface model from curve objects describing the vein boundaries, fitting an SGrid to the model and interpolating the gold grades in the SGrid using DSI. Resources with more than 0.3 ppm are mined profitably. A fault is truncating the reservoir separating a low-Au part in the north from a high-Au part in the south. We want to visualize the minable volume and to estimate the minable gold weight considering interpolation errors along the fault.

3.4.2. Modelling of an SGrid between two geological boundaries

First, we create an SGrid filling the box. We have to define the size of the grid in relation to the box and the number of voxel in XYZ coordinate direction (Nu, Nv, Nw).

SGrid \rightarrow \text{New} \rightarrow \text{From Objects Box} \rightarrow \text{name: augrid} \rightarrow \text{objects: box} \rightarrow \text{Nu: } 100 \text{ Nv: } 60 \text{ Nw: } 10 \rightarrow \text{property cell centred} \rightarrow \text{ok}

If you want to visualize the SGrid, you can use the object panel:

attribute manager \rightarrow \text{volume} \rightarrow \text{tick full volume} \rightarrow \text{ok}

The grid has to be fitted to the modelled surfaces by

SGrid \rightarrow \text{Tools} \rightarrow \text{proportional between top and bottom} \rightarrow \text{final horizon: top_surface} \rightarrow \text{reference horizon: bottom_surface} \rightarrow \text{ok}

Interpolate the permeability on the SGrid with DSI:

SGrid \rightarrow \text{Constraints} \rightarrow \text{Set Property Control Points} \rightarrow \text{Gridobject: augrid} \rightarrow \text{AtomsSet: au_grades}
SGrid \rightarrow \text{Interpolation} \rightarrow \text{Initialize Property (Muli-Grid)} \rightarrow \text{Gridobject: augrid} \rightarrow \text{property: Au} \rightarrow \text{region: everywhere} \rightarrow \text{Advanced} \rightarrow \text{tick: use all values}

You can visualize the property distribution by ticking

Object \rightarrow \text{Panel} \rightarrow \text{SGrid} \rightarrow \text{augrid} \rightarrow \text{properties} \rightarrow \text{permeability}

View the modelling result and analyse it in the histogram window! Compare it to the input data set! Are you content with the modelling results?
4.1. Introduction

One very important field of gOcad application is to estimate property values like ore grades or porosity in the whole modelling volume from a few measurement points.

gOcad offers two algorithms to estimate properties in 3D: DSI and Geostatistics. DSI yields good results in interpolating of smooth geological surfaces, but yields infeasible results, if properties are estimated in space. Therefore, the geostatistical analyser of gOcad is the more suitable tool, if the project work aims to predict properties.

Geostatistics is a methodology for interpolating spatial data. This means, each data value is associated with a location in space and there is at least an implied connection between the location and the data value.

Suppose that \( t \) is a location that is not “sampled”. The objective of property modelling is to estimate/predict the value \( Z(t) \). The value of the property at the unsampled location is not itself random, but our knowledge of it is uncertain. We have to use a modelling approach to estimate the property and this approach must incorporate the idea that there is uncertainty associated with the estimation step. If we want to predict a property at a location \( t \) from measurements in other locations, we have to assume, that one can constrain \( Z(t) \) by its neighborhood: if a spatial continuity is assumed, \( Z(t) \) can only have values similar to the ones found in the neighborhood. Conversely, in the absence of spatial continuity, \( Z(t) \) can take any value and cannot be predicted.

The advantage of geostatistical methods is, that all our knowledge about the spatial distribution of our data can be included in the prediction model:

- spatial covariance
- trends
- anisotropies

However, if we want to include much knowledge in the prediction model, we have to analyse the data set very carefully prior to performing an interpolation. Therefore, we need to get familiar with the data set.

4.2. Data set

The data set WellPoints.vs consists of 861 data points consisting of spatial and property values at each sampling point. By observing the data set in the 3D camera, you get a first impression of its spatial distribution: About 12 data points are located at an identical \( XY \) position that is coincident with one vertical well. The whole data set reproduces the geometry of an anticline with a curved hinge line. The data set describes a structural oil trap. Each data point comprises the properties core porosity, log porosity and permeability.

4.3. Exploratory data analysis

4.3.1. Visual data analysis

Exploratory data analysis (EDA) is an approach to analysing data for the purpose of formulating ideas about the distribution of a property and about relation and dependence of different properties in the same data set. Visual data analysis is a very important step in
geostatistical modeling, since the ability of the human eye to find patterns, relations or misfits in a data set is much better than any computer algorithm. The objective of visual data analysis is to

- Characterize one property
- Detect relationships among different properties

gOcad provides several data analysis tools that can be either accessed via the Application toolbar or via the Compute Menu.

- Histogram
- Cross Plot
- 3D Cross Plot
- Spatial Data Analysis

Relationships between properties can be found, if the proper scale is used. Gocad allows for changing the maximum and minimum value of a diagram axis as well as the scale that may be linear or logarithmic.

4.3.2. Areal distribution of measurement points

Let’s have a look at the areal distribution of the data set:

Cross Plot → object: WellPoints → region: entire object → X-Axis property: X → Y-Axis property: Y → use equal minimum and maximum values for both axes and a linear scale

The areal distribution of the data is irregular, this is good for spatial data analysis, since it covers a wide range of distances between the data points ensuring a good spatial data analysis.

![Areal distribution of sampling points](image)

Fig. 4.a. Areal distribution of sampling points

4.3.1. Characterization of the property distribution

Now let’s check all three properties with the histogram tool and let’s answer the following questions:

How are the properties distributed (uni- or multimodal, symmetric or asymmetric)? Which characteristic numbers do they have? Do you find outliers?
Histogram → object: WellPoints → region: everywhere → property: coreporosity → read the characteristic numbers in the first box on the left side → always play with the number of bins change to 100 decrease to 20 to see whether new peaks appear → interpret number of modes, skewness, geometry of the distribution.

Fig. 4. b. Histograms for the coreporosity, the logporosity, the permeability on a linear and a logarithmic scale. Boxplots for all properties. Note the outliers in the permeability boxplot.
The porosity has a bimodal distribution with two peaks. This phenomenon is either an indication that the data set includes multiple geological units like clay lenses in a sandstone or that the rock formation was affected by secondary processes like cementation of pore space.

Instead, the permeability that is expected to be a function of the porosity, is skewed to the right and looks like a log-normal distribution. Therefore, let’s change the scale to log10 and have a look at the data. Now, we observe again the bimodal distribution found in the porosity histograms. Another thing is important in the permeability set: We notice outliers with extremely high permeabilities. This may indicate the existence of a thief zone in the reservoir. A thief zone is a very permeable formation encountered during drilling into which circulating fluids can be lost. Thief zones, which include crevices, cavens and porous formations, must be sealed off with a liner or plugged with special cements or fibrous clogging agents before drilling can resume. Therefore, it is important to discover and to locate the thief zone. Create a region containing all data points with a permeability higher than 600. Where is the thief zone located?

Region → Create → object: WellPoints → region: thiefzone
Region → Initialize → from property range → object: WellPoints → region: thiefzone → property: perm → use min: 600 → ok

Fig. 4. c. Data points (green) and points with extremely high permeability (red). All points with high permeability are located at the top of the data set. However, this is not visible in a cross plot, because of the anticlinal structure of the sampled formation.

4.3.3. Bivariate data analysis

The bivariate data analysis deals with the relation between two properties and can be performed with the cross plot tool that can create and scale cross plots. Additionally, Pearson’s correlation coefficient and the linear regression coefficient are displayed. For better data analysis, the data have to be exported to statistics software like S-Plus or R.

How are the properties related to one another? Plot the cross plots and scale them, change the scale from linear to logarithmic, if necessary.

You see that the core porosity and the log porosity are highly correlated, but are not equal. The core porosity is systematically higher than the log porosity, which may be caused by expansion of the core after its exhumation. Since the log porosity was measured in situ, we assume it to be more realistic and will work with it. If you print a cross plot between log porosity and permeability, you find that there may be a functional relation between both properties, but that this relation is not linear. This is evidenced by a difference in the correlation and rank correlation coefficient (fig. d). If you logarithmize the permeability, the correlation coefficient is increasing considerably, however, the regression line is still somewhat asymmetric, which is caused by the outliers pulling the regression line upward. Create a region “without outliers” and create a new regression model. Now, you see that it is more symmetric and the correlation coefficient as well as the coefficient of determination are better.

gOcad offers a tool to view 3D cross plots, but a real multivariate data analysis has to be performed in an external statistics software.
4. Spatial data analysis

4.4.1. The variogram

Spatial data analysis comprises all techniques analysing the distribution of a property in space. Spatial data analysis is the fundamental step in geostatistical property interpolation, since it provides the parameters that are used for the specification of the prediction model.

The main instrument used for spatial data analysis is the variogram. The variogram describes the degree of spatial dependence in a data set. It relates the variance of the difference in a property at pairs of sample points to the separation distance between those pairs. This relationship can in addition be calculated for different directions. We distinguish empirical and theoretical variograms. The empirical variogram is derived from the sampling points and is used to read the parameters of the theoretical variogram. The theoretical variogram is a function describing the spatial dependence of a properties by a mathematical model including parameters derived from the empirical variogram. Thus, variogram modelling involves user decisions and is to some extent subjective. Parameters that are important for generating an empirical variogram in GeoCAD are:

- **LAG DISTANCE**: The lag distance defines the incremental distance at which the variogram is calculated. The lag distance should be at least equal to the minimum sample spacing. On the other hand, it has to be several times smaller than the range, if this shall be properly displayed. Since you do not know the range when starting a spatial data analysis, you have to change the lag distance and to play with it. As a rule of thumb, use a lag distance of half the diagonal of the data extent divided by 20.

- **LAG**: specifies the maximum number of length-steps, usually, you should choose a number of >20 to get enough data points for modelling of the theoretical variogram.

- **SAMPLING RATE**: specifies which percentage of the data set is included in the variogram analyses. If the data set is very big (more than 100 000 points), you can consider using a sampling rate smaller than 100 in order to accelerate the computation.

- **UWV SPACE**: is parallel to the coordinate system defining an SGrid. The distance is the fraction of the total dimension of the grid. The distance between two cells come to 1/(number of cells). A smaller number than this cannot be used.

---

Fig. 4. Cross plots and linear regression model (red) between the properties of the reservoir data set with PCC - Pearson’s Correlation Coefficient, SCC - Spearman’s Correlation Coefficient, COD - Coefficient of Determination, LRC - Slope Coefficient of the linear model.
• **XYZ SPACE**: is parallel to the data point coordinates. The distance is defined in meters.

The data can be transformed to:

• **Normal score**: transforms the data to a Standard Gaussian Distribution. When this transformation is used, the sill is set to 1 and sill modelling can be neglected in variogram modelling.

• **INDICATOR TRANSFORMATION**: Transforms all data values either to 0 or 1. The user must specify the value of interest (for discrete type of transformation) or a cut-off value (for continuous type of transformation). The data are transformed to 1 if they are equal to the value of interest or smaller and equal than the cut-off, else to 0.

The parameters specifying a theoretical variogram function are:

• **NUGGET EFFECT**: microvariability, the intercept in the theoretical variogram

• **RANGE**: The distance to which spatial dependence can be determined

• **SILL**: the variance of the data set outside of the range

The ranges in a variogram usually have a „natural“ meaning, for example the thickness of a geological horizon containing one chemical element or the size of a land use type. Therefore, we will read the variogram parameters by eye and adapt the gOcad variogram model to the empirically determined value.

![Image of a variogram](image)

**Fig. 4. e. Parameters of a variogram**

### 4.4.2. 1D vertical variography with a single well

**THE DATA SET**

The vertical variogram analyser is used to explore the vertical spatial behavior of a property and to combine the vertical variogram with the areal variogram analysis to a 3D model.

Visualize the curve object Well1 and the SGrid Well1SG.

Well1 presents a vertical well with 12 data points and a property quality, which classifies the rocks due to their lithological properties. This property has a cyclic pattern.

Well1SG is an SGrid including the Well1 data points with 28 cells aligned in vertical direction and with the cell specification U1 V1 W28. Its U axis is parallel to the X axis and the W axis is parallel to the Z axis.

Start the gOcad variogram analyser with

**Applications → Spatial Data Analysis**

A window pops up that comprises of two parts, the operation menu and the variogram display window.

**XYZ VARIOGRAM**

The XYZ variogram uses only the data set and ignores the SGrid.

Tick the folder Domain and define, which data set, which coordinate system and which property transformation shall be used.
Select data → Input data: Well1 → Property: Quality → sampling rate: 100%
Coordinate transformation → no transformation
Property transformation → no transformation
Compute → vertical → choose number of lags, lag distance, number of columns
variogram type: conventional → compute variogram

Which lag number do you choose? 11, max possible number

When I calculate the lag size with the rule of thumb given above, I would get a lag distance of 250 m. Is this distance sensible? Which distance would you choose? Why? 500 m, min distance between two data points

Change the number of lags and the lag distance and see how the variogram changes!

The variogram displays a cyclic spatial pattern of 2500 m distance. If the lag distance is too big, this pattern is not reproduced by the variogram. If the number of lags is high, the variogram still consists of 11 data points, which is the maximum, since we have only 12 data points.

UVW VARIOGRAM

The computation in the UVW space refers to the coordinate axis of an SGrid and is cell-based. For proper variography, you have to make sure that the cell spacing is fine enough relative to the data spacing. The lag distance is defined as fraction of the total dimension of the grid.

Select data → Input data: Well1 → Property: Quality → sampling rate: 100%
Coordinate transformation → UVW transformation → using grid object: Well1SG
Property transformation → normal score
Compute → vertical → choose number of lags: 28, lag distance: 0.035, number of columns: 1
variogram type: conventional → compute variogram

4.4.3. 1D variography with multiple wells

In the last section, you learned how to create a vertical variogram. Calculate XYZ variograms for the permeability of the WellPoints data set. Read and write down the range, the sill and the nugget effect from the variograms. How do you interpret the decreasing of the function at very high lag distances? Write down the maximum lag distance without this effect and reduce the number of lags to avoid the effect.

The number of data pairs used for the calculation of one variogram point decreases if the lag distance increases. Therefore, variogram points for long distances are not very reliable. If only few data pairs are used, the variance mostly decreases. This effect has to be neglected for modelling of the theoretical variogram.
4.4.4. 2D areal variogram analyser

Areal variograms give an impression about ranges in horizontal direction. gOcad provides the facilities to perform directional variogram analysis in order to find anisotropies in the property distribution.

- If the user works in a **XYZ SPACE**, the data space defined by minimum and maximum Z values is divided into 100 horizontal layers.
- If the user works in a **XYW SPACE**, the top and base layer have to be specified for definition of the W direction. The space between top and base will be divided in 100 layers.
- If the user works with an **UVW SPACE**, a grid object has to be specified and the space is subdivided in 100 layers parallel to the W axis.

![XYZ space](image1)

![XYW space UVW space](image2)

*Fig. 4. g. Subdivision of a data space in 100 levels indicated by the black lines for areal variography according to the specified working space*

For directional variography, the 2D space is subdivided in multiple wedges specified by an azimuth. Directional variogram analysis requires a few additional parameters that have to specified in the „Compute“ window:

- **AZIMUTH**: angle of the direction in which the lags are created
- **TOLERANCE**: defines the half-width of a wedge in which data pairs are included. If the tolerance is too small, possibly only very few data pairs are included into the directional variogram.
- **BANDWIDTH**: specifies the maximum width of the wedge in terms of a distance to the centre line of the wedge. The default value in XY space is 1/4 of the shortest extension of the data set and in UV space it is 0.2.

If you want to create an omnidirectional variogram, you have to choose a tolerance of 90. Then, you get only a single variogram that is valid for all directions.

Create areal XYZ variograms for the permeability of the data set Wellpoints in the same variogram analysis window that you used for the vertical variography. Work with **no** data transformation. Read the minimum distance of two data pairs with the „Get Distances“ tool in a
top view. Use it as first lag distance. Specify the number of lags by the rule of the thumb. Play with the directions, lags and lag distances to get an idea, how the variograms change. An anisotropy is indicated by a significant difference in range. Find the directions with minimum and maximum ranges and read the variogram parameters. Use additional variogram directions.
Now, we want to create a variogram ellipsoid describing the spatial distribution of the data set. This means, we want to fit an ellipsoid to the variogram ranges and directions.

Range 1 in the modelling window corresponds to the major semi-axis of the ellipsoid, range 2 is the short semi-axis of the ellipsoid. These ranges are computed from the directional areal variograms. Range 3 is the axis of the vertical component that is decoupled from the other two axes.

First, we need an uniform set of variograms in all horizontal directions. Therefore, we have to rescale the lags of all variograms. The „Settings“ window can be used to set the variogram scales manually. By default, each of the variogram plots is scaled automatically. You can rescale the axis, change colors and symbols of the variogram points.

Domain → Coordinate transformation: UVW transformation → Grid object: reservoir_grid → property transformation: normal score

Compute → recalculate vertical and areal variograms

Choose a maximum lag, such that the range is well visible, but that no break-down of variance for the high lag sizes is visible. Choose a uniform scale for the Y axis showing all data.

Settings → rescale X axis: min: 0 max: ?? → rescale Y axis: min: 0 max: ??

Now, we move to the „Modelling“ window.

The „nested variogram structure“ section is used for building several nested models in different layers, not to create different models at the same level. So, do not press New!

Click in the variogram → a theoretical variogram appears that is represented by a curve → Click on the curve → hold and move it to apply the ranges and sills you read from the empirical variogram → Or: type the values in the modelling window on the left side → Choose „current“ or „all“ in the variogram edit section to change only one or all of the variograms → Specify the azimuth of the major axis in the modelling window according to the direction of the longest range you found

Display the variogram ellipsoid in the 3D camera. If you do not see the ellipsoid increase the ranges or change the dip angle!

3D camera → type: SGrid → object: reservoir_grid

When you are content with your model, press the button „Save to file“ and add the extension *.vg to save the variogram model in a gOcad variogram file.

Open a new variogram window and repeat the variography for the same data set, but in UVW space. When you are content with the variogram model, save it in a file (perm_uvw.vg).

4.5. The gOcad variogram file

The variogram file consists of two parts. The first part contains parameters used for variogram computation. The lines start with „#“ and are ignored by gOcad, when the file is loaded into the variogram modeler. The second part specifies the spatial correlation of the data.
• **COORDINATE SYSTEM:** specifies the coordinate system of the variogram model. The variogram model will be used in this coordinate system.

• **KRIGING TYPE 1:** This is currently a ghost line and is not used by gOcad.

• **MAX CLOSE 16:** This means that a maximum of 16 data points that are nearest to the point of estimation are included in the interpolation. The line is created independently on the variogram modelling and can be / should be modified by the user. Test what happens, if you use all data points. Since the data get a weight according to their spatial relation determined by the variography, the estimation should theoretically be based on all data points.

• **KRIGING OPTION 1:** This line refers to the kriging method that shall be used. 0... simple kriging, 1... ordinary kriging. Simple kriging assumes a known constant mean, ordinary kriging assumes an unknown constant mean.

• **SEARCH ELLIPSOID:** The search ellipsoid is specified by six numbers. They are the results of the variogram modelling. The first three numbers specify the azimuth, dip, rotation of the variogram ellipsoid. The next three numbers axis a, axis b, axis c are twice range1, range2, range3. The rotation angle specification is eliminated from the variogram analyser to simplify the modelling. So rotation is set to zero, when you save the variogram model.

• **SPHERICAL:** specifies the variogram function. The first word specifies the variogram model and can be spherical, gaussian, exponential or power. The next numbers are azimuth, dip, rotation, range1, range2, range3. If the model is derived from 2D+1D modelling, the dip is always Zero.

The variogram file should **only** be used in the same SGrid that was used to model the variogram, that covers the data points and that is fitted to the top and base surface of the geological unit that was sampled.

### 4.6. Kriging - the geostatistical interpolation

Kriging belongs to the family of linear least squares estimation algorithms. A kriging estimator is said to be linear, because the predicted value is a linear combination of the data that are weighted by their spatial covariance. The kriging predictor minimizes the variance of the prediction error. When you perform a kriging in gOcad, two SGrid properties will be computed: the property estimate and the kriging variance.

The Geostatistics Menue appears in the Operation Menu Bar, when you switch to the SGrid mode. You have to choose an interpolation method

\[\text{SGrid} \rightarrow \text{Geostatistics} \rightarrow \text{Estimation} \rightarrow \text{Kriging} \rightarrow \text{Grid object: reservoir_xyz} \rightarrow \text{Region: everywhere} \rightarrow \text{Discrete property: WellPoints} \rightarrow \text{Region: everywhere} \rightarrow \text{Property: permeability} \rightarrow \text{New property prefix: _kriging} \rightarrow \text{Gs file: permeability_xyz.vg}\]

Additionally to the least square estimate of a property, kriging also provides the error variance. This variance is zero at the data locations and increases away from the data. The kriging variance is bigger at a location surrounded by data of very different values than at a location surrounded by data of similar values. However, how can the kriging variance be used in evaluating the modelling result? Is the variance of one interpolation big or small? This depends on the data, and therefore, the kriging variance can only be used in relation to the variance of the data set itself. In the XYZ permeability model we found a sill of 35000, the data set has a variance of 36000 (squared standard deviation). The kriging variance is in the order of 1, which is very small in comparison to the variance of the data set. So we can be content with the kriging result from this point of view.
Fig. 4. k. Results of property interpolation. First row left: the data points with color-coded property permeability. First row right: interpolation with DSI smoothes out the thief zone. Second row left: interpolation in an XYZ space reproduces the thief zone, but overestimates it, such that wells with normal permeabilities at the top of the reservoir are badly reproduced. Second row right: interpolation in a UWW space reproduces as well the thief zone as low permeability zones in the top of the reservoir.

Fig. 4. l. Kriging variance of the interpolation in XYZ space
**ANALYSIS OF MODELLING RESULTS**

5.1. *Display properties of a property in an SGrid*

You can display modelling results along cross sections perpendicular to the coordinate axes (fig.a).

Object Panel → SGrid → properties → right click on porosity → attributes → property sections → choose axis and choose position of the cross section either by typing the number of the grid row or by pushing the bar right to the axis-selection bottom.

![Fig. 5.a. SGrid with interpolated (left) and sections through the SGrid (right).](image)

5.2. *Visualization of permeable and non-permeable parts*

Permeable parts of the oil deposit can either be visualized by iso-surfaces separating highly and less permeable volumes (fig. b) or by SGrid regions including all highly permeable cells (fig. c).

![Fig. 5.b. Iso-surface separating mineable from non-mineable parts (right).](image)
**Iso-surfaces**

Surface → New → From Grid → Grid Iso-Property → name: 600 → property: permeability → isovalue: 600

**Regions**

Regions can be created in a similar manner as regions in PointsSets.

SGrid → Region → Create → object: grid → region: permeable

SGrid → Region → Initialize From Property Range → object: grid → region: thief → property: permeability → Use Min Min: 600 → ok

The region has to be copied in order to calculate a complement region „no-thief“:

Object Panel → SGrid → grid → regions → mineable → right click → copy object: grid → from: thief → to: no-thief → ok

Region → Edit → Complement → object: grid → region: no-thief

**Query cell numbers and region volumes**

You can check the number of voxels in the entire SGrid and in the regions and you can calculate the volume of the region.

Cells of the entire SGrid: Object Panel → grid → attributes → info

Cells of a SGrid region: augrid → regions → thief → right click → Compute → Cell number in region

Volume of a region: augrid → regions → thief → right click → Compute → Region volume

**Define regions with respect to a fault**

Regions can also be defined by their position to a surface cutting the grid. Digitize a surface and edit it by dragging one node with the mouse, if the grid is not completely cut by the surface.

Object panel → right click on surface → New → from digitized polygon → digitize with right clicks → end with left click → name: cut

Surface → tool → node → drag with mouse

Now, we want to create an SGrid region south to the surface.

SGrid → region → create → south

SGrid → region → initialize from surfaces → name: south → surface: cut

Visualize the region and compute the complement, if necessary!

![Visualization of permeable and non-permeable parts](image)

Fig. 5. c. SGrid region to the south of a surface.
5.3 Analysis of the results of property modelling

If a property was modelled, the modelling result has to be analysed with simple statistic tools and the data distribution of the estimates has to be presented visually and described by characteristic numbers. You can work with the SGrid in the same way as with the primary data, this means you can produce cross plots and histograms and read statistical numbers. Use these tools to compare the interpolation results with the primary data. Usually, you will try several interpolation methods and make a decision, which one(s) is (are) the best.

In this example, the histograms and the statistical numbers show that DSI brings the worst modelling results. The distributions of the estimates in XYZ and UVW space are similar to the primary data and to one another. What do you recommend to your client concerning his problem? Where is it worth to drill? Where is it worth to proceed with mining, where not? Where to be careful? Where are the modelling results uncertain? Where do you need more data, what sort of data?

<table>
<thead>
<tr>
<th></th>
<th>Median</th>
<th>Mean</th>
<th>Standard derivation</th>
<th>1st Quartil</th>
<th>3rd Quartil</th>
</tr>
</thead>
<tbody>
<tr>
<td>data</td>
<td>44</td>
<td>108</td>
<td>191</td>
<td>26</td>
<td>115</td>
</tr>
<tr>
<td>DSI</td>
<td>35</td>
<td>44</td>
<td>160</td>
<td>-4</td>
<td>79</td>
</tr>
<tr>
<td>UVW space</td>
<td>47</td>
<td>87</td>
<td>110</td>
<td>34</td>
<td>82</td>
</tr>
<tr>
<td>XYZ space</td>
<td>41</td>
<td>94</td>
<td>138</td>
<td>30</td>
<td>88</td>
</tr>
</tbody>
</table>

Table 5. a. Statistical numbers for the property estimation
5.4. Cutting through the model

5.4.1. The slicer

goCad provides two tools that you can view your model from “inside”.

The slicer allows moving through the model and creates a sequence of sections parallel to the faces of the slicer box. The slicer can be found in the camera toolbar. First, you have to activate the slicer function by clicking on the icon “slicer”. Then, click on “edit slicer” and on one surface of the slicer box to define the slicing direction. Now, you can move through the model, if you keep the left mouse button pressed and move the mouse. The translation axis is displayed in yellow. If you don’t see anything, click on “reset slicer” in the camera toolbar. The default slicing directions are parallel to the coordinate axes. If you want to change this, click on the “rotate slicer” icon and then on the slicer box and move it while pressing the left mouse button. The rotation axis is displayed in yellow. Finish the slicer mode by a second click on the slicer icon.

Fig. 5. e. The slicer is active. Upper right corner: the slicer icons

5.4.2. Cross sections

You can produce and export cross sections projecting goCad objects in a plane.

First, we want to create a cross section correlating drilling holes.

Object panel → cross section → right click → New → From digitized polyline → Digitize the cross section line

When you press the right mouse button for finishing the line, the cross section view is created. On the left side of the window, you see the object panel. Pick those objects you want to see in the cross section. You can also display the pillars.

At the right side of the window, you can see the cross section toolbar with icons similar to the other goCad toolbars. Click on “global view” to show the whole cross section. You can choose various zoom options to display a part of the cross section: the box zoom and the strip zoom, you may show or hide the grid. If you click on one object in the object panel, a Quick Edit Bar appears at the bottom of the window and you can edit the layout of the object. You can create a cross section showing one horizon in one color, if you tick the “solid painting” option. Finally, you can display color-coded properties. The cross section can be exported by clicking on the “export as file” icon in the cross section toolbar.

If you close the cross section window, you see the location of the section in the 3D camera.
Volcanogenic massive sulfide ore deposits (VMS) are a type of poly-metal sulfide ore deposits, which are associated with and created by volcanic hydrothermal events in submarine environments. In modern oceans they are synonymous with sulfurous plumes called black smokers. VMS deposits are predominantly layered accumulations of sulfide minerals that precipitate from hydrothermal fluids on the seafloors. Depending on the density of the metals, they form a large or narrow areole around the volcanic center.
The project „black smoker“ comprises data from a polymineral VMS deposit in Peru. The concentrations of five metals were sampled. The objective of the exercise is to characterize the element distribution in the deposit and to reconstruct the locations of the black smokers. The data set was imported with a wellmarker file, the well markers were transformed to PointsSets, describing the geometry of the ground surface („ground“), of the hanging wall and bottom wall of the deposit („up“, „low“) as well as the metal concentrations („grades“). The geometry of the deposit was modelled by the two surfaces „slow“ and „sup“ and a SGrid was adapted to these surfaces. However, the width of the SGrid was chosen larger than the thickness of the deposit, in order to guarantee that all data values lie inside the SGrid and can be used for interpolation.

6.2. Modelling steps

Perform a univariate data analysis and characterize the distribution of the metals (modes, median, mean, deviation, variance, skewness, outliers).

Characterize the bivariate relationships between the elements (correlation, rank correlation).

Perform a spatial data analysis and create variograms for the spatial distribution of the metals. Use the UVW transformation on the SGrid. Interpret different ranges found for different metals.

Interpolate the metal concentrations for the VMS deposit.

Show the location of the volcanic centers. How does the interpolation result match the results of the statistical and spatial data analysis?